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1 Document Overview 

These Application Notes describe the configuration steps required for the Sonus Session Border Controller 
(SBC) 1000 and SBC 2000 to interoperate with the Genesys 8.1 system and a SIP trunk group to PSTN.  

The objective of the document is to describe the configuration procedures to be followed during interoperability 
testing of SBC 1000 and SBC 2000 with a Genesys system and T1 trunk group to PSTN.  

For additional information on Sonus SBC 1000 and SBC 2000 series, visit http://www.sonus.net 

For additional information on Genesys, visit http://www.genesys.com 

 

1.1 Overview 
 

The Sonus SBC 1000 and SBC 2000 session border controllers have been designed to use the same application 
software, boot image and Survivable Branch Appliance software. They differ in the number of physical Ethernet 
connections and processing power but are otherwise viewed from a software standpoint as being the same.  
With this in mind, this particular effort was tested with an SBC 1000 but is fully applicable to an SBC 2000. 
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2 Introduction 

This document provides a configuration guide for Sonus SBC 1000 Series (Session Border Controller) when 
connecting to a SIP PSTN trunk group and a Genesys 8.1 PBX. 

The Sonus SBC 1000 and SBC 2000 are Session Border Controllers that connects disparate SIP trunks, SIP 
PBXs, and communication applications within an enterprise. The SBC can also be used as a SIP routing and 
integration engine.  

The Sonus SBC is the point of connection between the SIP trunk group to PSTN and the Genesys PBX.  

2.1 Audience 
 

This technical document is intended for telecommunication engineers with the purpose of configuring  the Sonus 
SBC 1000 and SBC 2000 and aspects of the SIP trunk group together with Genesys 8.1 product. There will be 
steps that require navigating the third-party and Sonus SBC Command Line Interface (CLI). Understanding the 
basic concepts of IP/Routing and SIP/RTP is also necessary to complete the configuration and for 
troubleshooting, if necessary. 

This configuration guide is offered as a convenience to Sonus customers. The specifications and information 
regarding the product in this guide are subject to change without notice. All statements, information, and 
recommendations in this guide are believed to be accurate but are presented without warranty of any kind, 
express or implied, and are provided “AS IS”. Users must take full responsibility for the application of the 
specifications and information in this guide.  
 
Technical support on SBC 1000 and SBC 2000 can be obtained through the following: 

• Phone: +1 888-391-3434 (Toll-free) or +1 978-614-8589 (Direct) 

• Web: http://www.sonus.net/company/maintenance/log-trouble-tickets 

 

2.2 Requirements  
The following equipment and software was used for the sample configuration provided: 

Sonus Equipment Type Version 

SBC 1000 SBC 1000 4.1.0 Build 369 

 

3rd Party Equipment Type Version 

Genesys SIP Server 8.1.100.98 

Genesys GVP MCP 8.1.504.93 

Polycom SoundPoint IP 
501 SIP 

SIP Phone 2.1.3 

 
While the SBC 2000 was not tested, at the same time the results obtained for SBC 1000 would be seem with the 
SBC 2000 as they feature common code base. 
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2.3 Reference Configuration 
 

A simulated enterprise site consisting of a Genesys 8.1 PBX and a SIP trunk group to PSTN to connect to the 
SBC 1000.  The SBC 1000 was running software version 4.1.0 Build 396 during testing. 

 

 Network Topology  2.3.1
 

 

Genesys

Sonus 

SBC 1000

PSTNInternal IP Network

 

 

Figure 1: Network Topology 

The figure above represents the equipment used for the integration and certification testing. The SBC 1000 is 
used to route and facilitate calls between the PSTN and the Genesys system. 

The SBC 1000 under test has 2 Ethernet ports configured. For more information on Media port deployment 
options or other network connectivity queries, refer to the SBC 1000 Network Deployment Guide or contact your 
local Sales team for information regarding the Sonus Network Design professional services offerings. 
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3 Configuring Sonus SBC 1000 and SBC 2000 Series 

 

3.1 SBC Configuration Diagram 
 

Internal

Genesys SIP 

Server 8.1

External

Signaling Group:  To/From Genesys

Call Routing:  Calls from Genesys Signaling Group: PSTN-Ext-DN1

Call Routing:  Calls From PSTN-Ext-DN’s

10.35.176.111:5060

SIP

PSTN-Ext-DN1

PSTN-Ext-DN2
SIP

SIP RDN

Signaling Group: Genesys-RDN

Call Routing:  Calls From Genesys RDN

10.35.177.226:5060 10.35.177.226:5060

10.220.250.xxx:5060

 

Figure 2: SBC 1000 SIP Trunk Diagram 
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3.2 SBC Default Profiles 
 

 Default SIP Profile 3.2.1
 

SIP Profiles control the how the Sonus SBC 1000/2000 communicates with SIP devices. They control 
important characteristics such as: session timers, SIP header customization, SIP timers, MIME payloads, 
and option tags. Below is the default SIP profile used for the SBC 1000 for this testing effort. 

 

 

Figure 3: SIP Profile 
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 Default Voice Codec Profile 3.2.2
 

Below are the default voice codec profiles used for the SBC 1000 in this testing effort. 

 

 

Figure 4: G.711A Codec Profile 

 

 

 

 

Figure 5: G.711U Codec Profile 
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 Default Media Profile 3.2.3
 

Media Profiles allow you to specify the individual voice and fax compression codecs and their associated 
settings, for inclusion in a Media List. Different codecs provide varying levels of compression, allowing one 
to reduce bandwidth requirements at the expense of voice quality. Below is the default media profile used 
for the SBC 1000 and is for reference only. 

 

 

Figure 6: Default Media List 
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3.3 External Peer Side SBC Configuration 
 

 Node Interfaces 3.3.1
 

The Sonus SBC 1000 allows you to configure the Identification information, Physical Data Layer, and 
Networking Layer for the Ethernet ports. If you want to change the IP Address, you must configure the 
associated Logical Interface or use the Modify Ethernet IP task found under the Tasks tab. 

Below are the settings for the Ethernet connection between the Sonus SBC 1000 and trunks acting as 
PSTN. 

 Node Ports 3.3.1.1
 

 

Figure 7 : Node Port 
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 Node Interfaces 3.3.1.2
 

 

 

  

 
 

Figure 8:  Logical Interface 

 

 PSTN-Ext-DN’s 3.3.2

 SIP Signaling Group 3.3.2.1
 

Signaling groups allow telephony channels to be grouped together for the purposes of routing and shared 
configuration. They are the entity to which calls are routed, as well as the location from which Call 
Routes are selected. They are also the location from which Tone Tables and Action Sets are selected. In 
the case of SIP, they specify protocol settings and link to server, media and mapping tables. 
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Figure 9: SIP Signaling Group to PSTN-Ext-DN’ 
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 Call Routing Table 3.3.2.2
 

Call Routing allows calls to be carried between signalling groups, thus allowing calls to be carried between ports, 
and between protocols (like ISDN to SIP). Routes are defined by Call Routing Tables, which allow for flexible 
configuration of which calls are carried, and how they are translated. These tables are one of the central 
connection points of the system, linking Transformation Tables, Message translations, Cause Code Reroute, 
Tables, Media Lists and the three types of Signaling Groups (ISDN, SIP and CAS). 
 
 

 
 

Figure 10: Call Routing Table 
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 Transformation Tables 3.3.2.3

 
Transformation Tables facilitate the conversion of names, numbers and other fields when routing a call. They 
can, for example, convert a public PSTN number into a private extension number, or into a SIP address (URI). 
Every entry in a Call Routing Table requires a Transformation Table, and they are selected from there. In 
addition, Transformation tables will be configurable as a reusable pool that Action Sets can reference. 

 
 

 
 

Figure 11: Transformation Table matching Genesys extensions 

 

 
 

Figure 12: Transformation Table Matching all  
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 SIP Server Table 3.3.2.4
 

SIP Server Tables contain information about the SIP devices connected to the Sonus SBC 1000/2000. The 
entries in the tables provide information about the IP Addresses, ports, and protocols used to communicate 
with each server. The Table Entries also contain links to counters that are useful for troubleshooting. 

 

 

 
Figure 13: SIP Server Table  

 

 Remote DN’s 3.3.3
 

 SIP Signaling Group 3.3.3.1
 

Signaling groups allow telephony channels to be grouped together for the purposes of routing and shared 
configuration. They are the entity to which calls are routed, as well as the location from which Call 
Routes are selected. They are also the location from which Tone Tables and Action Sets are selected. In 
the case of SIP, they specify protocol settings and link to server, media and mapping tables. 
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Figure 14: SIP Signaling Group to Remote DN’s  
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 Call Routing Table 3.3.3.2
 

Call Routing allows calls to be carried between signalling groups, thus allowing calls to be carried between ports, 
and between protocols (like ISDN to SIP). Routes are defined by Call Routing Tables, which allow for flexible 
configuration of which calls are carried, and how they are translated. These tables are one of the central 
connection points of the system, linking Transformation Tables, Message translations, Cause Code Reroute, 
Tables, Media Lists and the three types of Signaling Groups (ISDN, SIP and CAS). 

 

 

 

 

Figure 15: Call Routing Table  
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 Transformation Table 3.3.3.3
 

Transformation Tables facilitate the conversion of names, numbers and other fields when routing a call. They 
can, for example, convert a public PSTN number into a private extension number, or into a SIP address (URI). 
Every entry in a Call Routing Table requires a Transformation Table, and they are selected from there. In 
addition, Transformation tables will be configurable as a reusable pool that Action Sets can reference. 

 

 

 

Figure 16: Transformation Table matching Genesys extensions 

 

 

 

Figure 17: Transformation Table matching all 
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 SIP Server Table 3.3.3.4
SIP Server Tables contain information about the SIP devices connected to the Sonus SBC 1000/2000. The 
entries in the tables provide information about the IP Addresses, ports, and protocols used to communicate 
with each server. The Table Entries also contain links to counters that are useful for troubleshooting. 

 

 

 

Figure 18: SIP Server Table 

 

 

 

3.4 Internal Side SBC configuration 
 

 Node Interface Ports 3.4.1
 

The Sonus SBC 1000 allows you to configure the Identification information, Physical Data Layer, and 
Networking Layer for the Ethernet ports. If you want to change the IP Address, you must configure the 
associated Logical Interface or use the Modify Ethernet IP task found under the Tasks tab. 

Below are the settings for the Ethernet connection between the Sonus SBC 1000 and trunks acting as 
Internal. 
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 Node Ports 3.4.1.1
 

 

Figure 19: Internal Node Interface Port 

 Node Interfaces 3.4.1.2
 

 

 

Figure 20: Internal Node Logical Interfaces 
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 Signaling Group 3.4.2
 

Signaling groups allow telephony channels to be grouped together for the purposes of routing and shared 
configuration. They are the entity to which calls are routed, as well as the location from which Call 
Routes are selected. They are also the location from which Tone Tables and Action Sets are selected. In 
the case of SIP, they specify protocol settings and link to server, media and mapping tables. 

 

 

 

Figure 21: Signaling Group 
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 Call Routing Table 3.4.3
 

Call Routing allows calls to be carried between signalling groups, thus allowing calls to be carried between ports, 
and between protocols (like ISDN to SIP). Routes are defined by Call Routing Tables, which allow for flexible 
configuration of which calls are carried, and how they are translated. These tables are one of the central 
connection points of the system, linking Transformation Tables, Message translations, Cause Code Reroute, 
Tables, Media Lists and the three types of Signaling Groups (ISDN, SIP and CAS). 

 

 SIP Call Routing Table to PSTN 3.4.3.1
 

 

Figure 22: SIP Call Routing Table To PSTN 

  



  

 

  24 of 56 

Copyright © 2014, Sonus and/or its affiliates. All rights reserved. 

 

 Call Routing Table To RDN 3.4.3.2
 

  

Figure 23: ISDN Call Routing Table To/From PSTN 

 Transformation Table 3.4.4
Transformation Tables facilitate the conversion of names, numbers and other fields when routing a call. They 
can, for example, convert a public PSTN number into a private extension number, or into a SIP address (URI). 
Every entry in a Call Routing Table requires a Transformation Table, and they are selected from there. In 
addition, Transformation tables will be configurable as a reusable pool that Action Sets can reference. 
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 Passthrough Untouched 3.4.4.1
 

 

Figure 24: Transformation Table to match all 

 To Remote DN 3.4.4.2
 

 

Figure 25: Transformation Table to Remote DN 

 

 

 

 

 

 



  

 

  26 of 56 

Copyright © 2014, Sonus and/or its affiliates. All rights reserved. 

 

 Local/Pass-thru Auth Table 3.4.5
 

Local Pass-through Tables contain entries with information about SIP endpoints, The Sonus SBC 
1000/2000 uses this information to challenge SIP request messages such as REGISTER. It is used in the 
SIP Signaling Group when the Challenge Request is enabled. 

 

 

Figure 26: Local/Pass-thru table 

 

 SIP Server Table 3.4.6
SIP Server Tables contain information about the SIP devices connected to the Sonus SBC 1000/2000. The 
entries in the tables provide information about the IP Addresses, ports, and protocols used to communicate 
with each server. The Table Entries also contain links to counters that are useful for troubleshooting. 

 

 

Figure 3: SIP Server Table 
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 Remote Authorization Table 3.4.7
 

Remote Authorization Tables and their entries contain information used to respond to request message 
challenges by an upstream server. The Remote Authorization tables defined in this page appear as options 
in the Remote Authorization and Contacts Panel for SIP Servers. 

 

 

 

Figure 28: Remote Authorization Table 
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4 Genesys configuration  

 

This section provides the configuration required for the Genesys components. 

4.1 Accessing Genesys Tools and Interfaces 
 

1. Genesys is configured using several different tools and interfaces. The tools and interfaces used in this 
document are shown below to include their location and method of access. 

 

To access these items, a Remote Desktop Connection (RDC) to the Genesys server is required. The 
username, password, and IP address of the system to be accessed should be provided by the person(s) 
installing the Genesys system. 

 

2. Once logged onto the Genesys system, click the Start button and look for the installed applications shown 
below. If the applications are not visible on the Start Menu, find them using 
the search box just above the Start button. 

 

The Solution Control Interface can be used to start/stop the various 
applications as well as identify the configuration of each application. 

 

The Configuration Manager is a tool that is used to configure and verify the 
many settings on the different applications. 

 

The Interaction Routing Designer is used to create and configure Route 
Points and strategies. 

 

Use Internet Explorer (not shown in the startup menu) to access the 
Genesys Administrator. The URI should be available from those who 
installed the platform. 

It is important to know that certain steps can be performed using multiple 
tools. For example, starting or stopping an application can be performed in 
the Genesys Administrator as well as the Solution Control Interface. 

 

3. Below is a snapshot of the Solution Control Interface. In this application, click View, top left, to gain access 
to the area of interest. Click Applications and expand the folders of interest. In this example, SIPServer1 
properties are displayed. Clicking the various links will display the appropriate property windows. You can 
Start/Stop/GracefulStop any application from within this tool. 
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Figure 4: Solution Control Interface 

 

 

4. The Configuration Manager is used to configure the platform and its applications. Once opened, click 
Applications/Media (it’s possible that your SIP Server is in a different folder under Applications) and the 
upper left pane will display both SIP Servers. Double-click SIPServer1 and a dialog box will open. To view 
all options for this server, click the Options tab, and then click the TServer section. 
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Figure 5: Configuration Manager 

 

Note that there are many option parameters. Type the name of the option in the filter and it will filter in real 
time. Some options can be set at both Application and Switch/DN levels. The option setting at the DN level 
takes precedence over the Application-level setting. See the Genesys SIP Server Deployment Guide for 
details.  

 

 

 

 

 

 

 

 

 

 

 

 

 

5. The Interaction Routing Designer is a tool used to create Route Points and/or Strategies. Access the 
Strategies by clicking “Routing Design” in the upper left and then select Strategies. Double-clicking any 
strategy will bring up a second window (not shown here). This second window is where Strategies can be 
created and modified. 

Figure 6: SIP Server Properties 
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Figure 7: Interaction Routing Designer 

 

6. Access the Genesys Administrator with a web browser. Contact the administrator or person(s) who 
performed the install of the system to determine the URL. Once opened, click the Provisioning tab and 
under the Navigation area click Switching. Under Switching, click Switches to display the names of the 
Switch objects. 
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Figure 8: Genesys Administrator - Switches 

 

Double-click the switch name and then click the DNs tab. The DNs for your SIP Switch will be shown. Each 
folder can be double-clicked to access the contents. Underlined are the bread crumbs for navigation. 
Circled is the icon area to add new DNs or delete existing ones. 

 

 

Figure 9: Genesys Administrator - DNs 
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4.2 Creating SIP Switch in Genesys Administrator  
 

1. Within Genesys Administrator, create Switching Office –> SIPServer Switching Office. 

 

 

Figure 10: Genesys Administrator - Creating SIP Switch 

 

 

 

2. Within Genesys Administrator, create a SIP Server Switch and associate the Switching Office created in the 
previous step with this switch.  
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Figure 11: Genesys Administrator - SIP Switch Association 

 

3. Under the SIPSwitch created in the above step, define Routing Points to run URS strategies from, the SIP 
trunk representing connection of SIP Server to Sonus, and a “msml” VoIP service DN required to integrate 
SIP Server with Media Server to support call hold and conferencing functionalities.  
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Figure 12: Genesys Administrator - Define Routing Points 

 

 

Subsequent steps of this section (see Step #8) provide additional details required to configure these DNs.  

 

4. Define DNs of type Extension under SIPSwitch with the following options in the TServer section for various 
SIP end points that will register to SIP Server. 

 

• use-contact-as-dn=true – Specifies whether SIP Server will use the username of the Contact header 

as ThisDN. 

• contact=* – Specifies the contact address of the extension DN to which SIP Server should send the 

SIP call. Here the Contact option value is the IP address of the internal interface of Sonus through 

which the SIP REGISTER message was received by SIP Server. 

• cpn=<2086041001> – SIP Server uses the value of this option as the user part of the SIP URI in the 

From header of the INVITE message that it sends from this DN to the destination DN. Since this option 

is used to provide customized caller-ID information to the destination, this option must be configured in 

the originating DN. 

• sip-cti-control=talk,hold – The SIP method NOTIFY (event talk) or NOTIFY (event hold) is used to 

request the end point to answer or place a call on hold, respectively. 
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Figure 13: Genesys Administrator - Extension Options 

 

5. Define a SIP trunk DN to represent all SIP calls arriving from the Sonus NBS internal interface to SIP 
Server. Configure the following options under the TServer section of the Trunk DNs. 

 

Trunk DN: 

• contact=<10.35.141.52:5060> – IP address and TCP/UDP port number of the SIP Signaling Port of the 

Sonus SBC 5000 configured for Genesys.  The SIP Signaling Port IP address is used by SIP Server to 

route or receive calls from test phones through this interface. 

• cpd-capability=mediaserver – Specifies whether SIP Server will use the username of the Contact 

header as ThisDN. 

• dial-plan=DialPlanInbound – Specifies which dial-plan DN will be applied to calls 

• prefix=<214340> – (NPANXX) Specifies the contact address of the extension DN to which SIP Server 

should send the SIP call. Here the Contact option value is the IP address of the SIP Signaling Port of 

the Sonus SBC 1000/2000 through which the SIP REGISTER message was received by SIP Server. 
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Figure 14: Genesys Administrator - SIP Trunk Options 

 

6. Defining a MSML voice over IP service DN with the following options in the TServer section: 

 

• contact-list=<IP Address:Port> – SIP IP address and listening port for Resource Manager. 

• oos-check=15 – Specifies how often (in seconds) SIP Server checks a device for out-of-service status. 

• oos-force=20 – Specifies the time interval (in seconds) that SIP Server waits before placing a device 

that does not respond in out-of-service state when the oos-check option is enabled. 

• prefix=msml= – Required for conference and monitoring services only. 

• service-type=msml – Specifies the configured SIP device type or service. 

• subscription-id=Resources – Specifies the type of subscription ID. 
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Figure 15: Genesys Administrator - Define MSML 

 

7. Verify GVP_RM Pair settings: 

• prefix=msml= – Required for conference and monitoring services only. 

• refer-enabled=false – Specifies the configured SIP device type or service. 

• ring-tone-on-make-call=false – Affects the TMakeCall request when using the re-INVITE procedure. 

When the ring-tone-on-make-call option is set to false, there is no ring tone. 

• make-call-rfc3725-flow=1 – Setting this option to 1 instructs SIP Server to use the 3pcc call flow as 

defined in the RFC 3725. 
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Figure 16: Genesys Administrator - GVP_RM Pair Settings 

 

8. Create DNs of type Routing Point in the SIPSwitch which should match the Request URI user part. In this 
instance it was extensions 1011-1015. 

 

 

Figure 17: Genesys Administrator - Create DN of Type Routing Point 
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Figure 18: Genesys Administrator - Routing Strategies 

 

9. SIP Server must have Full Control permission for the DN objects under the SIP Server Switch, in order to 
update various configuration objects under it, such as the Extension DNs. 

By default, it does not have this permission. You must grant “Full Control” permission for the System 
account for the all DNs on the corresponding switch. It is done for all DNs at once by changing the 
permissions for the system account on the DN folder in the switch object. Or, you can start SIP Server 
under another account that has change permission on the necessary DNs. 

With this full control access, the SIP Server Switch grants DNs like Extension to update their options like 
“contact” when a new SIP register message is received from end points moving to a new IP location.  

 

4.3 SIP Server Configuration in Genesys Administrator 
 

Follow these steps to configure SIP Server to monitor SIP Server Switch resources, such as SIP extensions/SIP 
end points registered to SIP Server. SIP Server also monitors various route points and notifies URS whenever 
the call arrives on the Route Point. 

 

1. Install and configure SIP Server as per Genesys Framework SIP Server Deployment Guide. 

 

2. Add a connection to the SIP Server Switch created above, to monitor all the resources under this switch: 
Genesys Administrator-> Provisioning->Environment->Applications->SIP Server Application. 

Also, SIP Server should add a connection to the tenant.  

 



  

 

  41 of 56 

Copyright © 2014, Sonus and/or its affiliates. All rights reserved. 

 

 

Figure 19: Genesys Administrator - SIP Server Tenant 

 

3. Add a connection to Message Server. 

 

 

Figure 20: Genesys Administrator - Add Connection to Message Server 

 

 

4. Configure the following options in the TServer section in the SIP Server Application object using Genesys 
Administrator or Configuration Manager: 
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• sip-enable-moh=true – Enables music on hold.  

• msml-support: true – This option and sip-enable-moh (above) allow SIP Server to integrated with 

Genesys Media server to provide msml/moml-based media services. 

• map-sip-errors=false – Genesys Universal Router makes the routing decision for the SIP Server-

based solution. If a call fails to route properly, the SIP Server generates an appropriate T-Library error 

message to inform the router. With this new parameter, SIP Server can now propagate SIP error 

messages to the router. Setting map-sip-errors=false triggers this functionality in SIP Server. 

• internal-registrar-persistent=true – Enables SIP Server to update the DN attribute contact in the 

configuration database. When an endpoint registers, SIP Server takes the contact information from the 

REGISTER request and updates or creates a key called contact in the Annex tab of the corresponding 

DN. 

• sip-dtmf-send-rtp=true – In order to support DTMF tone generation on behalf of a 3pcc-based SIP 

end point application such as  Interaction Workspace SIP end point. When this option is set to true, SIP 

Server requests Media server to generate RFC 2833 DTMF tones on behalf of the end point. 

• after-routing-timeout – Set to 10 seconds. If SIP Server does not get a response on routing a call to 

SIP agent/Extension DN, it will attempt to route the call to another DN (or default-dn) on expiration of 

this timer. You must set this timer to be less than the parameter rq-expire-tmout value of 32000 (32 

seconds). 

5. SIP Server is able to start properly with the proper FlexLM license installed. 

 

4.4 Genesys Media Server Deployment 
 

Follow these steps to configure a Media Server deployment. 

1. Media Server platform consists of Resource Manager and Media Control Platform applications in the 
Genesys Voice Platform product suite. To deploy, Media Control Platform and optionally a Resource 
Manager are required to be installed. When installed, Resource Manager serves as the ingress point to 
Media services and provides a MCP resource as a media service to the network/calling side. 

 

2. Install and configure MCP (Media control Platform) using the Genesys Media Server Deployment Guide. 

 

3. Within the MCP application’s Connections tab, add connections to SNMP Master Agent, Message Server, 
and Reporting Server (optional). 

 

The connections to applications are added for the following reasons: 
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Message Server - To ensure that component log information reaches the Log database and can be viewed 
in the Solution Control Interface (SCI) 

Reporting Server - (Optional) To ensure that these components detect the Reporting Server to which they 
are sending reporting data. 

SNMP Master Agent - To ensure that alarm and trap information is captured. 

 

4. Verify VoIP service DN of type=msml as specified in section 4.2, Creating SIP Switch in Genesys 
Administrator to support SIP Server-Media Server MSML interactions to support treatments and 
conferencing capabilities. 

 

5. To play music on hold (MOH) and music treatments, verify the following options are set in MCP and SIP 
Server: 

 

MCP->msml-> play.basepath = file://$InstallationRoot$ (this is the installation folder of Media Server. After 
this is, it will automatically look for the music sub folder). 

“MOH” and music treatments are located in the “music” folder. 

The ‘announcement” folder should contain ‘prompt’ files with proper IDs to support. Used in the URS 
Routing Strategies as mentioned in chapter 4.7. 

SIP Server->TServer->msml-support=true 

 

6. Install and configure Resource Manager as per Genesys Media Server Deployment Guide. 

 

Note: If SIP Server and Resource Manager are on the same machine and within the Resource Manager 
application, then the default SIP listening port number should be increased by 100 so the Resource 
Manager listening port is set to 5160 and the SIP Server application listens on port 5060. Make the 
necessary port changes within Resource Manager’s sip, proxy, register, subscription, and monitor sections. 

 

7. Within the Resource Manager application’s Connections tab, add connections to SNMP Master Agent, 
Message Server, and Reporting Server (optional). 

 

The connections to applications are added for the following reasons: 

Message Server - To ensure that component log information reaches the Log database and can be viewed 
in the Solution Control Interface (SCI). 

Reporting Server - To ensure that these components detect the Reporting Server to which they are sending 
reporting data. (Optional). 

SNMP Master Agent - To ensure that alarm and trap information is captured. 

 

8. Within the Integrating Media Control Platform with the Resource Manager, click the Media Control 
Platform Application object. The Configuration tab appears. 

Click the Options tab, and use the View drop-down list to select Show options in groups... 
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Select sip to find the routeset option. 

In the Value field, type the following: 

<sip:IP_RM:SIPPort_RM;lr> 

 

Where IP_RM is the IP address of the Resource Manager, and SIPPort_RM is the SIP port of the Resource 
Manager—typically, 5060. 

 

Note: You must include the angle brackets in the Value field in the sip.routeset and sip.securerouteset 
parameters. 

 

In the Value field of the securerouteset option, type the following: 

<sip:IP_RM:SIPSecurePort_RM;lr> 

 

9. G.729 media codec is not configured by default as a supported codec or as a codec that can be 
transcoded. This support can be enabled by adding “g729” as one of the values to the mpc.codec and 
mpc.transcoders space separated list.  The G.729 media codec was not provisioned in this Genesys 
deployment and is only mentioned here for completeness. 

Example:  

mpc.transcoders=PCM GSM G726 G729 

mpc.codec=g729 pcmu pcma g726 gsm h263 h263-1998 h264 telephone-event 

 

Alternately Media Server (specifically MCP component) can be configured to respond a multiple codec offer 
request with a single codec response. This feature support is available starting with MCP 8.1.4 release. 

This setting can be enabled by setting mpc.answerwithonecodec=1 (Default=0 – MCP responds to 
multiple codec offer with a multiple codec response list). 

 

10. This step is optional and is only required if multiple media control platform (MCP) instances are deployed 
and need to be controlled by Resource Manager for load balancing. 

 

Log in to Genesys Administrator. 

• On the Provisioning tab, click Voice Platform > Resource Groups. 
• On the Details pane tool bar, click New. 
• The Resource Group Wizard opens to the Welcome page. 
• On the Resource Manager Selection page, add the Resource Manager Application object for which you 

want to create the group. On the Group Name and Type page: enter MCPGroup or any custom name 
without spaces. Select type as Media Control Platform. 

• On the Tenant Assignments page, add the child tenant to which the Resource Group will be assigned. 
o Note: -The above bullet item is required only if you are creating the Resource Group in a multi-

tenant environment. 
• On the Group Properties page, enter the information as specified below for the Resource Group that 

you are configuring. 
 

o Monitoring Method: Retain the default value: SIP OPTIONS. 

o Load Balance Scheme: Select round-robin. 
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o Port Usage Type: Select in-and-out. 

o Maximum Conference Size: Enter -1. 

o Maximum Conference Count: Leave blank. 

 

Note: For the Media Control Platform group, the Max.Conference Size and Max.Conference Count, and the 
Geo-location options are optional. 

For a complete list of resource-group options and their descriptions, refer to  the Genesys Voice Platform 
User’s Guide. 

 

11. In this step, you create a default IVR Profile that can be used to accept calls other than those specified in 
the dialing plans. 

• Log in to Genesys Administrator. 
• On the Provisioning tab, select Voice Platform > IVR Profiles. 
• In the Tasks panel, click Define New IVR Profile. The IVR Profile Wizard opens to the Welcome page. 
• On the Service Type page, enter the name of the default IVR Profile, IVR_App_Default. 
• Select either Conference or Announcement from the drop-down list. (Only one service type per IVR 

Profile is supported.) 
• If you selected Conference, on the Service Properties page, enter a conference ID number. 
• If you selected Announcement, on the Service Properties page, enter the URL of the announcement, 

for example, http://webserver/hello.wav. 
• Click Finish. 

o Note: When you use the IVR Profile Wizard to create the default profile, the gvp.general and 
gvp.service-prerequisites sections are created for you and include the required parameters 

• In the gvp.general section of the Tenant’s Annex tab, set the default-application to this default IVR 
Profile name – IVR_App_Default. 
 

12. This completes installation and configuration of Media Server. Make sure Resource Manager and MCP are 
started successfully. 

 

4.5 Stat Server Configuration 
 

This section explains configuration of Stat Server that connects with T-Servers/SIP Servers and maintains 
agent and/or extension status which is used by URS during call routing. 

 

1. Install and configure Stat Server as per Genesys Framework Stat Server Deployment Guide. 

 

2. Add connections to SIP Server, Message Server to perform real-time monitoring of the SIP agent status. 
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Figure 21: Genesys Administrator - Stat Server Connections 

 

4.6 Universal Routing Configuration in Genesys Administrator  
 

This section explains how to configure a Universal Routing Configuration (URS) to support execution of call 
routing on SIP Server. 

 

1. Install and configure Universal Routing Server as per Genesys Universal Routing Deployment Guide. 

 

2. Add connections to Message Server, Stat Server, and SIP Server. 
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Figure 22: Genesys Administrator - URS Configuration 

 

Add connection to SIP Server to monitor events received by SIP Server for various route points and 
extensions on the SIP Server Switch. 

Add connection to Stat Server to query Stat Server for routing calls to available and ready agents. 

 
Use any of the strategies below to test your configuration.  

 

4.7 URS Routing Strategies 
 

This section shows examples of five URS routing strategies used during testing.  

 Strategy #1 - Route Call to Available Agent 4.7.1
 

When RP 1011 is invoked, this strategy routes the call to the next available agent. If no agent is available, 
it plays MOH until one becomes available. 
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Figure 23: URS Strategy #1 

 

 Strategy #2 - Play Announcement and Route to Available Agent 4.7.2
 

When RP 1012 is invoked, this strategy plays an announcement and routes the call to the next available 
agent. If no agent is available, it plays MOH until an agent becomes available. 

 

  

Figure 24: URS Strategy #2 
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Figure 25: URS Strategy #2 - Target Selection 

 

 

 Strategy #3 – Play Announcement and Collect Seven Digits 4.7.3
 

When RP 1013 is invoked, this strategy verifies that any seven digits can be collected and then routed to 
an available agent. If no agent is available, it plays MOH until an agent becomes available. 

 

 

Figure 26: URS Strategy #3 
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Figure 27: URS Strategy #3 - Prompt Tab 

 

 

Figure 28: URS Strategy #3 - Busy Tab 

 

 

Figure 29: URS Strategy #3 - Target Selection 

 

 

 Strategy #4 – Route to External SIP Carrier Number 4.7.4
When RP 1014 is invoked, this strategy immediately routes the call to an external SIP Carrier number. 
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Figure 30: URS Strategy #4 

 

 Strategy #5 – Route to External SIP Carrier Number 4.7.5
 

When RP 1015 is invoked, this strategy plays an announcement and then immediately routes the call to an 
external SIP Carrier number. 

 

 

Figure 31: URS Strategy #5 
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Figure 32: URS Strategy #5 - Prompt Tab 

 

 

 

 

Figure 33: URS Strategy #5 - Function Properties 
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5 Exceptions  

5.1 SBC1000/2000 Exceptions  

 Call hold using RFC 2543 method 5.1.1
 

This method is not supported by the SBC1000/2000 because its obsolete and replaced by  RFC 3264. The 
workaround is to create Message Manipulation Rules applied on Internal Signaling Group that will match 
connect IP 0.0.0.0 and replace a=sendrecv with  a=inactive. 

SIP Message Manipulation feature is used by a SIP Signaling Group to manipulate the incoming or 
outgoing messages. This feature is intended to enhance interoperability with different vendor equipment 
and applications, and for correcting any fixable protocol errors in SIP messages on fly without any changes 
to firmware/software. 

 

 

Figure 46: Message Rule Table 

 

 

 

Figure 60: Message Manipulation Rule 1 
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Figure 61: Message Manipulation Rule 2 

 

Appendix A   

 

SIP Server and DN configuration  
 

SIP Server standard configuration 
 

sip-hold-rfc3264=true  

router-timeout=30 

default-dn= 

blind-transfer-enabled=true  

resource-management-by-rm=true 

msml-support=true 

sip-enable-moh=true 

 

DN standard configuration  
 

Name 
Number Name in 

CME 
CME Options TServer 

section 
Comment 

MGW-
TRUNK 

MGW-
TRUNK 

MGW-
TRUNK 

refer-enabled=true 
contact=<TSE_CONTACT> 
oos-check=10 
oos-force=5 

TSE 
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oosp-transfer-enabled=true 
sip-replaces-mode=2 

Ext-DN1 
Ext-DN2 

2221234567 
2221234568 

N/A N/A  

SIP-DN1 
SIP-DN2 

2086041020 
2086041021 

1020 
1021 

refer-enabled=false 
ring-tone-on-make-
call=false 
make-call-rfc3725-flow=1 
contact=* 

 

SIP-RDN 2076041025 1025 refer-enabled=true 
ring-tone-on-make-
call=false 
make-call-rfc3725-flow=1 
contact=* 
sip-cti-control=talk,hold 

SIP endpoint 
which 
supports the 
BroadSoft 
SIP 
Extension 
Event 
Package. 

SIP-UNKN 2086041025 N/A N/A  

RP 2086041011 1011   

RP1 2086041012 1012   

RP2 2086041013 1013   

SVC_MSML SVC_MSML SVC_MSML prefix=msml= 
contact=<MS_CONTACT> 
service-type=msml 
subscription-id= 
Environment 

MS 

 

SIP Server and DN non-standard configuration per test case  
 

12: Caller is put on hold and retrieved by using RFC 
2543 method SIP SERVER: sip-hold-rfc3264=false  

15: 3PCC Alternate from consult call to main call 
SIP-DN1 

refer-enabled=true 

17: 1PCC Attended Transfer to external destination: 
MGW-TRUNK 

refer-enabled=false, oosp-transfer-enabled=true 

21: 3PCC Single Step Transfer to internal busy 
destination using REFER 

MGW-TRUNK: refer-enabled=true; sip-busy-type=2 

22: Early Media for Inbound Call to Route Point with 
Treatment 

MGW-TRUNK: sip-early-dialog-mode=1 

23: Early Media for Inbound Call with Early Media 
for Routed to Agent 

MGW-TRUNK: sip-early-dialog-mode=1 

24: Inbound call routed outbound (Remote Agent) 
using INVITE without SDP 

MGW-TRUNK: oosp-transfer-enabled=false 

25: Call Progress Detection: MGW-TRUNK cpd-capability = mediaserver; refer-enabled=false 

27: SIP Authentication for outbound calls MGW-TRUNK: on the Annex tab configure 
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AuthClient section with options 
username=<username> password=<password> 

28: SIP Authentication for incoming calls MGW-TRUNK: authenticate-requests=invite 
;password=1234 

29: T-Lib-Initiated Answer/Hold/Retrieve Call for 
Remote SIP endpoint which supports the BroadSoft 
SIP Extension Event Package 

SIP-RDN: sip-cti-control=talk,hold; authenticate-
requests=REGISTER; password=1234 

32: 1PCC Attended Transfer from Remote SIP 
endpoint to external destination 

MGW-TRUNK: refer-enabled=false 

 

EpiPhone configuration 
 

Content of configuration file esttt.conf: 

 

[TcCM] 

site1 = UTE_HOME 

connect-on-startup  = true 

open-log-on-startup = false 

log-to-file = epi-phone.log 

#------------------------------------------------------------------------------ 

[UTE_HOME] 

server = (host=<SIP_SERVER_HOST_IP>,port=<SIP_SERVR_TLIB_PORT>) 

sip-register = false 

dn1 = 7101,name="Alice",mkcall="7102" 

dn2 = 7102,name="Bob" 

dn3 = 7200,name="John" 

dn50 = 5000,script=",pool="shared" 

dn5=5001,pool="shared",script="annc=(PROMPT=(\"1\"=(INTERRUPTABLE=1,ID=1)))" 

dn6=5002,pool="shared",script="collect=(MAX_DIGITS=4,RESET_DIGITS=11,BACKSPACE_DIGITS=22,T
OTAL_TIMEOUT=100)" 

 


